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1 Appliance information  

 Introduction 

This guide provides information about the “SAP S/4HANA 2023 (FPS02), Fully Activated Appliance” on SAP Cloud Appliance 

Library (SAP CAL, https://cal.sap.com ). 

The appliance contains an SAP S/4HANA system with pre-configured SAP Best Practices and demo scenarios.  

 

Typical use cases are trial, sandboxing, proof-of-concept, or scoping exercises.  

The usage as a development system in implementation projects is not recommended since the appliance might contain 

components and configuration settings (some with a separate license) that are conflicting with the later deployment in a quality 

or production system. 

 

Via SAP Cloud Appliance Library, the appliance can be rapidly brought up as your personal appliance with administrative rights 

in dedicated hyper-scalers such as Amazon, MS Azure or Google Cloud Platform (setup time ~2 hours).  

SAP also offers to use the appliance on your own hardware e.g. in your data center (setup time usually ~2-3 days), please see 

SAP Note 2041140 if you are interested in this deployment option. 

 

Important information about the lifecycle of the system:  

Once the system has been successfully provisioned in your SAP CAL account, it is under your ownership and control (you have 

all-area admin authorizations in your appliance). SAP does not access or maintain this system in any way after provisioning, and 

you will not receive any updates by SAP. 

If you consider upgrading to a higher release (either a major release or an FPS), this will need to be done as a customer-specific 

project (using maintenance planner, SUM, etc.). Depending on your situation, it might be easier to create a new appliance for 

the newer release, and transport/export any important artifacts from the older release. 

 

What has changed in this appliance release compared to past releases ? 

- The release cycle for SAP S/4HANA has changed to a two-year release cycle, see https://news.sap.com/2022/09/new-

sap-s4hana-release-maintenance-strategy/ for more details. 

Nevertheless, the SAP S/4HANA 2023 FPS02 release contains many new features (incl. SAP Best Practices content), 

see the according What’s New of the SAP documentation and the SAP Process Navigator (section 1.3 in this 

document) 

 

- The authorizations of the pre-configured demo users have been reduced to allow for a more realistic testing of 

business user behavior.  

Except for a few users (eg. BPINST), the demo users don’t have the SAP_ALL profile anymore but only the generated 

profiles of their assigned roles, plus manual additions where needed to run the respective demo scenarios. If you 

encounter issues with these authorizations, you can check what exactly is missing (tCode SU53), or manually assign 

SAP_ALL to the demo users (tCode SU01 for single changes, SU10 for mass changes).  

 

Further information: 

https://cal.sap.com/
https://launchpad.support.sap.com/#/notes/2041140
https://news.sap.com/2022/09/new-sap-s4hana-release-maintenance-strategy/
https://news.sap.com/2022/09/new-sap-s4hana-release-maintenance-strategy/
https://help.sap.com/whats-new/5fc51e30e2744f168642e26e0c1d9be1?Product_Line=SAP+S/4HANA;SAP+S/4HANA+and+SAP+S/4HANA+Cloud+Private+Edition&Version=2023+FPS02&locale=en-US
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- A general introduction into the appliance and the usage as trial or sandbox system can be found on 
https://blogs.sap.com/?p=727457 

- Known issues will be continuously updated in this blog: https://blogs.sap.com/?p=1636309 . 

- Extensive demo guides with sample walkthrough scenarios can be found here: 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/. 

- Video tutorials how to create a hyperscaler account and launch the appliance can be found here.  They might not 

necessarily show the creation of the SAP S/4HANA 2023 appliance (but another SAP appliance template), however, 

the concepts are the same.  

 

  

https://blogs.sap.com/?p=727457
https://blogs.sap.com/?p=1636309
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/
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 Installed products 

When you deploy the appliance, you get access to a system landscape that has been built using the following components (see 

picture below). 

1. SAP S/4HANA on the SAP HANA database 

2. SAP NetWeaver 7.50 JAVA with Adobe Document Services (on Sybase ASE database) 

3. Optional: Microsoft Windows Server (as remote desktop) for easy frontend access. 

4. Optional: SAP BusinessObjects BI Platform  

 

 

Notes:  

• The virtual machines (VMs) for the BI Platform and the remote desktop (RDP) are optional in Cloud Appliance Library. 

You can deselect these two VMs in the Advanced Mode of the appliance creation. Once an appliance has been 

created, this choice cannot be changed anymore for this appliance. 

Please consider deploying the remote desktop (even if it slightly increases the hyperscaler costs) since it provides a 

good way of testing and troubleshooting potential network access issues. 

• Please make sure to have enough quota in your desired hyperscaler account & region (the needed quota can be 

found on https://cal.sap.com → Appliance Templates → <Desired_Template> → Calculate Cost. 

• The BI Platform and the remote desktop are only available when using SAP Cloud Appliance Library as described in 

this document. However, you can also receive the virtual appliance for installation on your own on-premise hardware 

but in that case BI platform and remote desktop are not included. Please see SAP Note 2041140 for the option to 

install the virtual appliance on your own hardware.  

 

A detailed component list of the appliance can be found in the appendix of this guide.  

 

  

https://cal.sap.com/
https://launchpad.support.sap.com/#/notes/2041140
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 Business scenarios & localizations 

The appliance uses SAP Best Practices as main business content.  

Details about the scope of the SAP Best Practices for SAP S/4HANA (valid for both on-premise and private cloud deployments) 

can be found on the SAP Signavio Process Navigator (S-user needed): https://me.sap.com/processnavigator/SolS/EARL_SolS-

055/2023-FPS02  

 

 

The SAP Best Practices configuration content of SAP S/4HANA 2023 FPS02 is available for 43 local versions:  

Australia, Austria, Belgium, Brazil, Canada, China, Czechia, Denmark, Finland, France, Germany, Hong Kong, Hungary, India, 

Indonesia, Ireland, Italy, Japan, Luxembourg, Malaysia, Mexico, Netherlands, New Zealand, Norway, Philippines, Poland, 

Portugal, Romania, Russia, Saudi Arabia, Singapore, Slovakia, South Africa, South Korea, Spain, Sweden, Switzerland, Taiwan, 

Thailand, Turkey, United Arab Emirates, United Kingdom, United States 

 

In the appliance, all available localizations are activated in client 400 (see the section ABAP client structure & business users 

later in this guide), however, the suggested demo walkthroughs incl. demo data in the appliance are configured in client 100 for 

USA only, using the company code 1710. 

Although the SAP Best Practices have been fully activated, there are still areas that require additional configuration to be fully 

functional. The integration into other SAP products or 3rd party software is such an example where you need to specify e.g., the 

credentials (tenant, account, etc.) of the integration target.  

 ABAP client structure & business users 

Multiple ABAP clients are configured in the appliance: 

• 000 serves as standard delivery client (as usual in on-premise deployments) 

• 100 is the primary demo client that contains pre-configured scenarios and sample data.  

o Pre-defined demo scenarios , see the demo scenario page in SAP community 

https://me.sap.com/processnavigator/SolS/EARL_SolS-055/2023-FPS02
https://me.sap.com/processnavigator/SolS/EARL_SolS-055/2023-FPS02
https://blogs.sap.com/?p=796653
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▪ Demos often based on SAP Best Practices for SAP S/4HANA 2023 FPS02 

▪ Further additional configuration for sample business processes outside SAP Best Practices 

▪ Demo flows are designed for the US localization (e.g., customizing and transactional demo data 

are in the US company code 1710) 

o This client does not contain the “pure” SAP Best Practice activation: 

▪ It’s based on the merged-000-client approach 

▪ SAP Best Practices have been continuously applied after system upgrades and are not fully 

activated in client 100 (see client 400 for a full activation in a greenfield setup). 

• 200 can be used for activating the SAP Best Practices on your own.  

Please  see the SAP Best Practices implementation guide for details. Be aware that some of the SAP Notes and 

settings mentioned in the guide still need to be applied depending on what country or scope you activate (e.g., the 

parameter rdisp/scheduler/prio_high/max_runtime is not set accordingly yet as required by the guide). 

• 400 contains the activated Best Practices (BP) based on the BP client approach for all localizations 

o SAP S/4HANA 2023 FPS02 Best Practices activation (43 localizations*) 

o This is the standard delivery state of Best Practices (no additional configuration, no corrections applied) 

o Some scope items might not be activated (e.g., if certain configurations required an either/or decision); this 

is especially the case for scope items of Universal Parallel Accounting or Decentralized EWM. Similarly, not 

all scope items are available in all localizations. 

o Use case: Explore/compare the standard SAP Best Practices customizing for specific countries 

 

Please see chapter 2 for default users and logon procedures. 

 

(*) For the US localization, SAP Best Practices are delivered with internal tax calculation. This includes sample jurisdiction codes 

and sample rates so that you can execute the best practices test scripts. The organizational structure and chart of accounts are 

activated with SAP Best Practices sample content.  

Client 200 does not contain these settings. 

(**) For information on the differences between an SAP Best Practice and a merged-000 client, please see here. Especially 

please make sure to understand that client 400 does not contain the whole “usual” customizing that you might know from 

https://help.sap.com/viewer/4cef93946a0b48ec89533b3c34443b85/2021/en-US/17d958a88d244ee293aed687f9bfe37f.html
https://help.sap.com/viewer/4cef93946a0b48ec89533b3c34443b85/2021/en-US/8a5680cd5c2045d3b461bc7f35b25a64.html
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client 000. Therefore, especially if you use scenarios outside the SAP Best Practices scope, they might not work as expected 

without further customizing by you (you might even experience coding errors due to this). 

 

Suggestion how to use the clients: 

We recommend starting with client 100 to get familiar with the appliance and its data & configuration structure, although the 

two activated localizations (US & Germany) might not 100% fit to your business case. Use the demo guides (see next section of 

this guide) to understand the scenarios of your choice in more detail.  

If you want to evaluate the SAP Best Practices for your country, have a look at client 400 for the needed configuration settings 

(eg. via tCode SPRO or the respective maintenance transactions and views). Client 400 is not tested, and it does not contain 

transactional demo data (the sample master data of SAP Best Practices are activated though), hence, you might need to invest 

additional effort there. 

If you intend to copy client 400 to another client for further testing, please keep in mind that it does not contain the full 

customizing of client 000 and that you might be missing customizing data. 

Client 200 is empty and can be used to activate your own set of SAP Best Practices. Especially if you activate subsets of SAP Best 

Practices, existing activation experience will come handy. You can also copy client 000 into your own client if you want to 

experience the whole flow, see the SAP Best Practices guide for the respective options. 

 Sample demo walkthroughs 

Once you have created an appliance in SAP Cloud Appliance Library you will have a principally working S/4HANA system that 

you can explore and change on your own.  

To give you a jump-start into the contained scenarios, we have documented a wide range of example scenarios that we 

recommend as starting point to get more familiar with the system.  

Please see this blog (https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/)  for the available 

demo guides (choose the applicable release). 

These demo guides take you on a “guided tour” through some of the pre-configured areas, but you are also free to step away 

from these tours.  

However, if you explore additional features of the SAP S/4HANA system beyond what is provided in the demo guides, you might 

find functions or processes that are not pre-configured and, hence, will not provide a meaningful system response. In this case, 

you need to configure those scenarios or functions using SAP standard procedures (e.g., via transaction SPRO) to make them 

work. 

You might also find errors as you explore the appliance. In this case, please search for SAP Notes and corrections and decide if 

you want to apply them. Your appliance behaves like a regular customer system and will not be updated automatically by SAP 

i.e., you will need to implement these fixes in your system. 

 Recommended post-installation steps 

As said above, your appliance will be a working system, however, since the appliance is entirely under your control (SAP does 

not maintain it) there are certain settings that you might need to adapt depending on your use case, for example: 

 

1. Evaluate and adapt security settings  

When you create the appliance in your hyperscaler account, by default it will be deployed in the public Internet, i.e., 

https://community.sap.com/t5/technology-blogs-by-sap/sap-s-4hana-fully-activated-appliance-demo-guides/ba-p/13389412
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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everyone with Internet connectivity can access your system.  

We strongly recommend applying additional security measures as you consider it needed for your context. Chapter 4 

of this guide mentions typical aspects and suggestions. 

 

2. Open the MM inventory management period for the current month if you intend to post goods movements.  

The above blog with the sample demo scenarios explains how to do this in section C  . 

 

3. Check further time-dependent settings if you face issues  

This is like adapting the MM period above: Since the appliance comes in a defined state (with development close 

some time before you start your appliance), you might need to adapt time-dependent settings e.g., validity dates of 

master/meta data, certain finance periods, time-dependent production windows, and so on. 

 

4. Register the appliance system under your customer installations and apply license keys.   

Please see chapter 3 of this guide for details, in summary you will need to consider two timelines: 

- If you intend to use the system beyond 30 days, you will need to possess licenses for SAP S/4HANA and SAP 

Cloud Appliance Library 

- If you intend to use the system beyond 90 days, you will need to generate and apply your own license keys to 

the HANA DB, S/4HANA, and JAVA 

 

Both options are only possible with an S-user (i.e., a registered SAP customer user). A public P-user can only register 

for the 30-day trial. 

 

5. Create own business users if the pre-configured demo users are too “heavy”.  

The pre-configured S/4HANA demo users (see section 2.4.1.1.) often have many roles assigned to enable them for a 

broad business scenario.  

As mentioned in the introduction, starting with SAP S/4HANA 2023 FPS02 most of them do not have an SAP_ALL 

authorization profile anymore, however, please check if the authorizations are suited to your scenario.  

If these users are too broad for your specific project, you could either create your own users in tCode SU01 (there is 

no contractual limit for user numbers during the trial period) or use the SAP Fiori Rapid Activation to create users with 

tailored role assignments (see the demo walkthrough page in the “User Experience & Extensibility” section for the 

respective guide).  

 

6. Enable the automatic download of SAP Notes 

The appliance has been technically prepared for connecting it to the SAP support backbone infrastructure.  

However, for using the automatic download and application of SAP Notes (via tCode SNOTE), you need to enter your 

customer-specific S-User credentials in the usual SM59 RFC destinations (SAP-SUPPORT_PORTAL, SAP-

SUPPORT_PARCELBOX, SAP-SUPPORT_NOTE_DOWNLOAD). 

 

7. On the included remote desktop:  Install Eclipse (incl. HANA plug-ins) and change the default browser  

 

Installing Eclipse 

The Welcome page on the remote desktop has detailed instructions how to use the provided PowerShell script. If you 

like, you can also manually install Eclipse and the corresponding SAP plug-ins from 

https://tools.eu1.hana.ondemand.com/  

 

Default browser 

The remote desktop still uses Internet Explorer (IE) as default browser. Since IE is deprecated by Microsoft and does 

not support many SAP applications anymore, you might get error messages if you open a web-based transaction 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://tools.eu1.hana.ondemand.com/
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(NWBC, BRF+, etc.) from the SAP GUI.  

 

There are two options how to overcome this: 

 

(1)  

We recommend to change the default browser on the remote desktop to Chrome or Edge (the latter needs to be 

installed by you) since these browsers will work with the SAP GUI (to do this, search for “Choose a default browser” in 

the Windows menu and change the browser icon in the app). 

 

(2)  

If (1) is not suitable for whatever reason, you can also enable the myssocntl  service in S/4:  

tCode SICF → right-click on service “default_host > sap > public > myssocntl” → Activate → Confirm. 

With this setting, web-based transactions will use the browser that is defined in the installed SAP Logon options (in 

SAP Logon, choose Options > Interaction Design > Control Settings > HTML Control ). On the remote desktop, this uses 

the MS Edge/Chromium libraries as default. 

This setting will  also eliminate the need to enter an additional logon in certain business scenarios that merge SAP GUI 

and browser content. 

However, there is a potential issue with this setting when using SAP GUI directly from your corporate PCs (without 

remote desktop) since the above HTML control requires SAP GUI 7.70 or higher. If your business users have older SAP 

GUI versions installed on their local PCs, they might get errors when opening web transactions from a local SAP 

Logon.  

SAP Note 2624143 describes the background. 

 More information & support 

1.7.1   More information 

Overview blog in SAP Community: https://blogs.sap.com/?p=727457  
 

Known issues blog in SAP Community: https://blogs.sap.com/?p=1878499  

 

Post installation steps and sample demo walkthroughs: 

https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/ 

 

SAP S/4HANA Trial Landing Page (also containing a “Quick Start Guide” how to set up the appliance if you haven’t done this 

before reading the document in front of you): 

https://www.sap.com/products/erp/s4hana-private-edition/trial.html  

 

Video tutorials (how to create Cloud Provider accounts and start an SAP S/4HANA appliance): 

https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/  

https://launchpad.support.sap.com/#/notes/0002624143
https://blogs.sap.com/?p=727457
https://blogs.sap.com/?p=1878499
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
https://www.sap.com/products/erp/s4hana-private-edition/trial.html
https://blogs.sap.com/2021/03/19/sap-cal-learning-videos-update/
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1.7.2   Support 

If you run a 30-day trial (i.e., no SAP Cloud Appliance Library subscription license), please use the SAP Community (preferably 

take SAP Cloud Appliance Library as it’s closely monitored): 

• SAP Cloud Appliance Library (for Cloud Appliance Library usage, access, etc.):  

https://answers.sap.com/tags/67837800100800004473  
 

• SAP S/4HANA (for S/4 specific functional questions): https://answers.sap.com/tags/73554900100800000266  

 

If you have an SAP Cloud Appliance Library subscription license acquired, you can also report an incident (component BC-VCM-

CAL). Ideally you have registered your appliance system under your customer installations before so that you can report the 

incident on the right system. 

https://answers.sap.com/tags/67837800100800004473
https://answers.sap.com/tags/73554900100800000266
https://support.sap.com/en/my-support/incidents.html
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2 Accessing the appliance 

 Overview 

The appliance can be accessed via a preconfigured Windows remote desktop (option 1) or via client tools on your local PC 

(option 2). 

For the first steps with the appliance (especially for the personnel that has set up the appliance), we recommend the access via 

the remote desktop since it has multiple client tools and pre-configurations included.  

However, since only two users can log on to the remote desktop in parallel (at least without additional Microsoft licenses), this 

might be impractical if you want to provide the appliance to additional users. For this case, the access via a local computer will 

be better suited but for full access to all Fiori capabilities you will either need to modify the local /etc/hosts file (see 

chapter 2.3.1) or apply a fully-qualified host name to your appliance (see chapter 2.3.2). 

 Option 1: System access via embedded Windows Remote Desktop 
frontend server 

 After your own appliance is created, click the Connect button in the Appliances view of the console. 
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 In the pop-up, click Connect in the “RDP Virtual Machine: Windows Remote Desktop” line. 

 

 

 Confirm the pop-up window to allow Remote Desktop Connection (click on “Connect”). 

Enter user Administrator (local domain of the remote desktop) and your <Master Password> that you specified during the 

appliance creation in the SAP Cloud Appliance Library console. 

 

 

 

 Next you will see the pre-configured Windows RDP server desktop.  

Follow the information on the Welcome page to logon to the SAP S/4HANA system (Fiori link, SAP GUI/HANA Studio are 

pre-installed on the desktop, etc.). The Welcome page shortcut on the desktop points to 

C:/ProgramData/WelcomePage/Welcome.html. 

More details on pre-configured appliance users can be found in section 2.4. 
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 Further remarks: 

- The embedded Windows Remoted Desktop license allows 2 concurrent sessions (e.g., one for the existing user 

Administrator and one for another user that you can create on the remote desktop). Installing your own RDP 

license might also be an option to allow more concurrent users on the RDP.  

- Eclipse and the needed SAP plugins for accessing the HANA database will not be installed by default. Please 

execute the MS PowerShell script on the desktop to automatically install Eclipse and the needed SAP plugins (the 

Welcome page on the RDP has more details). 

- If your cloud provider infrastructure has restricted Internet access (e.g., in a fenced environment), the remote 

desktop will not be fully provisioned, and you must install certain components manually: 

o Chrome will not be installed → use Firefox for Fiori access or install Chrome at a later point in time if 

this is possible in your network setup  

o The Welcome page will not show up on the desktop, but you can find it on the remote desktop in the 

folder Q:\flavor\S4HANA_Fully_Activated\WelcomePage.  
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o The PowerShell script for installing Eclipse can be found on C:\Windows\eclipseinstall.ps1 

 Option 2: System access via local PC 

When accessing the system via your local PC, you will need to have the respective programs installed. A local browser (Chrome 

preferred) is obvious, but also a local SAP GUI, SAP Business Client or SAP HANA Studio (based on Eclipse) might be needed. 

 

SAP GUI Access: 

For SAP GUI access, you can use the “Connect → SAP GUI” option in the Cloud Appliance Library console  and a local SAP GUI 

will open. 

Or you can add the Cloud Appliance Library appliance to your local SAP Logon Pad or HANA Studio (use the <external IP address  

of the ABAP/HANA virtual machine> as host name, further details like system numbers, etc. are listed in section 2.4 ).  

If you don’t have SAP Logon/GUI installed locally, another option will be to use the WebGUI access. 

Simply use the <external IP address  of the ABAP/HANA virtual machine> in the following URL: https://<external IP 

address>:44301/sap/bc/gui/sap/its/webgui/#  

 

Fiori Access: 

The access to the Fiori launchpad via IP addresses will not work for apps that are based on WebGUI or Web Dynpro. For those 

to work, you will need to map the /etc/hosts file as described in the next section. 

As an alternative to the hosts file mapping and if you have access to a DNS service (corporate, free internet service, or the 

hyperscaler provides a  host name), you can also apply your own host and domain name to the system, possibly together with a 

registered SSL certificate. See section 2.3.2 of this guide for details.  

2.3.1   Mapping your local /etc/hosts file 

To make all Fiori launchpad capabilities work correctly when you access the appliance from your local computer, a mapping 

between the (external) IP address of your appliance and the appliance host name must be established. This mapping step is 

needed since the connection to the cloud providers uses IP addresses, whereas the S/4HANA system expects dedicated host 

names to work correctly.  

In the appliance the pre-defined host names in the appliance template are vhcals4hcs(and vhcals4hci) on the fictious 

domain dummy.nodomain.  

The easiest way to achieve this mapping is via editing a standard file on your local computer. 

(C:\Windows\system32\drivers\etc\hosts). However, you will need to have local administrator rights on your 

computer to edit this file. 

After you have done the mapping, you will be able to access the Fiori Launchpad of SAP S/4HANA via this URL: 

https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html  

If you cannot map your local hosts file (e.g., you don’t have administrator rights on your computer or there are security 

concerns in your environment), please check chapter 2.3.2 if using your own fully qualified host name is an option.  

For some isolated use cases, you can also put the external IP address of your S/4HANA & HANA appliance in the URL 

(https://<External_IP_Address_SAPS4HANA/HDB_server>:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html), 

however, not all applications and scenarios will work correctly with it e.g., CRM UIs or Web Dynpro applications might not 

correctly display, so you might hit issues in some business scenarios. 

https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html
https://vhcals4hcs.dummy.nodomain:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html
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The following describes how to modify the local hosts file on a Windows computer (for Mac, please search the Internet for 

options).  

 

 Open Notepad as administrator (search for Notepad on your computer > Right mouse click > Run as administrator): 

 Click File → Open and enter the following path: 

For Windows operating system:  C:\Windows\system32\drivers\etc\hosts  

For Linux operating system: /etc/hosts 

 Ensure to select All Files (*.*) 

 Open the hosts file and add the following lines to it (the IP addresses for the servers are displayed in the Cloud Appliance 

Library console in the appliance properties, take the external IP address): 

# S4H Appliance 

<External IP Address SAP S4HANA/HDB server> vhcals4hci.dummy.nodomain vhcals4hci 

vhcals4hcs.dummy.nodomain vhcals4hcs vhcalhdbdb vhcaldhbdb.dummy.nodomain 

<External IP Address SAP NW JAVA/ASE/ADS server> vhcalj2eci.dummy.nodomain vhcalj2eci 

vhcalj2ecs.dummy.nodomain vhcalj2ecs vhcalj2edb vhcalj2edb.dummy.nodomain 

<External IP Address SAP BI Platform> bihost bihost.dummy.nodomain  

 

 Save the hosts file and exit. 

2.3.2 Use your own fully-qualified host name & certificates 

Instead of mapping the default *.dummy.nodomain host name via the /etc/hosts file, you can also register a regular 

host/domain name in a DNS server of your choice and route this host name to the IP address.  

There are multiple options how to accomplish this; some will require the help of your corporate network/IT department, some 

can be done “do-it-yourself” with technical skills. 

• In a “corporate IT context” you can e.g., use your own corporate DNS resolution for the SAP S/4HANA system. This is 

typically done by your network / security basis team.  

• If the appliance runs outside a “corporate IT context”, you could either use a public low-cost DNS provider or check if 

the host name resolution of your hyperscaler can be used. For example, in AWS the machines typically follow a 

nomenclature like “ec2-<external_IP_Address>.compute-1.amazonaws.com” (use nslookup 

<External IP Address>  to check the naming convention). 

• Another option is the “fully-qualified domain” feature directly in SAP CAL. You can find this feature in the advanced 

creation mode in the CAL console in step 2 including a link to dedicated documentation. 

Once you have mapped the IP address and a DNS name, the Fiori launchpad can be reached under 

https://<Your_host_name>:44301/sap/bc/ui5_ui5/ui2/ushell/shells/abap/FioriLaunchpad.html , however some further settings 

need to be adapted in the S/4HANA system. 

 

On the demo walkthrough page a technical demo guide (in section (A) Demo Guides → Technical) shows the most relevant 

parameters that need to be switched from the *.dummy.nodomain host name to your real host name.   

 

The above guide also explains how to install a free 90-day Let’s Encrypt TLS/SSL certificate so that you can get rid of the 

“connection not secure” messages in the browser.   

https://community.sap.com/t5/technology-blogs-by-sap/sap-s-4hana-fully-activated-appliance-demo-guides/ba-p/13389412
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Please be aware that the guide might not comply with the security recommendations that are issued by your company or by 

SAP in general. Yet, the principal mechanisms, such as obtaining a signed certificate and importing it into the PSEs of the SAP 

systems, will also apply in a corporate context and might be helpful for your IT department. 

 

This table lists the different options for accessing Fiori and other web-based applications in the appliance: 

Method  Local admin 

for endusers 

needed ?  

Own 

domain 

needed ?  

Trusted SSL 

certificate 

included ?  

Effort  Comments / constraints  

RDP  No  No  Yes (added to 
local RDP cert 
store) 

Low  2 users max. in parallel 

Local /etc/hosts  Yes  No  No Low Needs Windows admin on local PC, 
MacOS might have additional 
constraints 

FQDN via CAL  No  Yes  Possible  Medium Documentation (also linked from the 
“advanced appliance creation mode” in 
the CAL console) 

FQDN via corporate 
DNS 

No  Yes  Possible Medium  Involve corporate IT / network team 

 Users & passwords for the system components 

2.4.1      SAP S/4HANA ABAP application server 

2.4.1.1 Pre-configured business users in SAP S/4HANA 

Note:  

Many of these users have a large set of roles and extensive authorizations in the system (eg. the SAP_ALL profile). Please check 

your scenarios and security considerations whether you want to use them or copy & adapt them accordingly.  

 

Client Business Content Sample users  

(password Welcome1 if not noted otherwise) 

000 

Standard delivery client 

• Nothing specific 

(standard customizing only) 

• BPINST 

• DDIC / SAP* (<Master_Password> 

100 

Trial & Exploration client 

• Pre-activated SAP Best Practices 

for SAP S/4HANA 2023 (Germany 

& US, sample demo flow localized 

for US) * 

• Customizing and transactional 

data in US company code (1710) 

• SAP Fiori Apps  

• S4H_AA_DEM / S4H_AA 

(Asset Accounting) 

• S4H_FIN_DEM / S4H_FIN 

(Finance) 

• S4H_CO_DEM / S4H_CO 

(Controlling) 

• S4H_MM_DEM / S4H_MM 

(Materials Management) 

https://caldocs.hana.ondemand.com/caldocs/help/FQDN_and_Certificates.pdf
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Client Business Content Sample users  

(password Welcome1 if not noted otherwise) 

• Based on the merged-client-000 

approach 

 

 

Note on the users: 

The demo users have a relatively broad set of 

roles and Fiori apps assigned for their 

respective functional area and should be 

primarily used for the initial  suggested demo 

walkthroughs.  

 

These users may have longer loading times in 

the Fiori launchpad, especially when using 

them for the first time or after a system 

suspension.  

Feel free to copy them to new user IDs (using 

transaction SU01) and adapt those new users 

to your needs.  

• S4H_PP_DEM / S4H_PP 

(Production Planning) 

• S4H_PM_DEM / S4H_PM 

(Plant Maintenance & Quality Mgmt.) 

• S4H_SD_DEM / S4H_SD 

(Sales & Distribution) 

• S4H_EXT 

(Extensibility) 

• S4H_EWM_DEM 

(Warehouse Management) 

• S4H_PPM_...  

(Portfolio & Project Management) 

• S4H_TM_DEM (Transportation 

Management) 

• S4H_PRED 

(Predictive Analytics) 

• S4H_MG 

(Data Migration) 

• SERV_EMPL / SERV_MAN / SLS_MAN / 

IC_AGENT_SRV / IHR_MAN  / MCS_MAN   

(SAP S/4HANA Service) 

• MDG_...  

(Master Data Governance) 

• S4H_HCM_…  

(Human Capital Management) 

• FIORIADMIN (Fiori customizing & 

roles) 

• S4H_AIF / S4H_AIF_ADM (Application 

Interface Framework) 

• BPINST 

(generic technical user) 

• DDIC / SAP* (<Master_Password> 

200 

Ready-to-activate client 

(white-list) 

• Ready-to-Activate client • BPINST 

• DDIC / SAP* (<Master password>) 

400 

SAP Best Practices 

reference client  

(white-list) 

• Pre-activated SAP Best Practices 

for SAP S/4HANA 2023 FP02 

without transactional data, no 

changes or corrections applied 

• BPINST  

• DDIC / SAP* (<Master password>) 

https://community.sap.com/t5/technology-blogs-by-sap/sap-s-4hana-fully-activated-appliance-demo-guides/ba-p/13389412
https://community.sap.com/t5/technology-blogs-by-sap/sap-s-4hana-fully-activated-appliance-demo-guides/ba-p/13389412
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2.4.1.2 Administrative data & users for SAP S/4HANA 

Connect to SAP S4H using the information in the table below (URLs with the host name vhcal… require hosts file mapping 

before, see chapter 2.3). 

 

Name Value Description 

SID S4H System ID of the SAP system 

Instance 

Number 

00 The instance number of the central instance (CI) 

Clients See section 1.4 These are the pre-configured clients 

Password for 

users DDIC &  

SAP* 

<Master Password> 

 

The master password is the password that you chose in the SAP Cloud 

Appliance Library when creating the appliance. 

The user SAP* is unlocked in client 100 only by default.  

In the other clients 000/200/400 it is locked. If you need there, please unlock it 

with another user (or use the temporary SAP* unlocking as described in SAP 

Note 3303172). 

ABAP 

administrator 

s4hadm /  

<Master Password> 

Additional user for ABAP lifecycle management – start/stop, administration, 

SAP Web 

Dispatcher 

administrator 

webadm / 

VA1MPwd_ 

or  

bpinst / Welcome1 

Access to Web Dispatcher console: 

https://vhcals4hcs.dummy.nodomain:44301/sap/admin  

User bpinst is case sensitive. 

 

Technical user 

for HANA DB 

connectivity 

(schema user) 

SAPHANADB /  

<Master Password> 

See tCode DBACOCKPIT → System Landscape → Database Connections for 

additional usage of the SAPHANADB user 

SAP Cloud 

Connector 

Administrator / 

manage 

Initial credentials for the integrated SAP Cloud Connector (access via 

https://vhcals4hcs.dummy.nodomain:8443) 

2.4.2 SAP HANA DB server 

Two database entities are relevant for the appliance: 

The tenant database (for storing the S/4HANA data) and the system database (for general database settings and actions e.g., 

maintaining the license key for SAP HANA). 

An entry for both is pre-configured in the HANA Studio on the remote desktop but you can also add entries in your local HANA 

Studio.  

 

 

Tenant database (use Single Container when adding it to your local HANA Studio) 

 

https://me.sap.com/notes/3303172
https://vhcals4hcs.dummy.nodomain:44301/sap/admin
https://vhcals4hcs.dummy.nodomain:8443/
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Name Value Description 

Tenant DB name  HDB System ID of the HANA DB 

Tenant DB Instance 

Number 

02 Instance number of HANA DB 

HANA SYSTEM user 

name 

SYSTEM /  

<Master Password> 

Standard HANA system user 

HANA administrator 

name 

hdbadm /  

<Master Password> 

Additional user for HANA lifecycle management – start/stop, 

administration functions, recovery. 

Generic HANA DB user BPINST / Welcome1 Generic user that can be used to access HANA DB  

Technical S/4HANA user SAPHANADB /  

<Master Password> 

Technical user for accessing HANA from the S/4HANA server. 

Defined in /nDBACOCKPIT; HANA schema SAPHANADB contains 

the S/4HANA data 

 

System database (use Multiple Containers → System DB when adding it to your local HANA Studio, needed e.g., for applying 

your own HANA DB license key) 

 

Name Value Description 

HANA DB system  SYSTEMDB System ID of the HANA DB 

HANA DB Instance 

Number 

02 Instance number of HANA DB 

HANA SYSTEM user 

name 

SYSTEM /  

<Master Password> 

Standard HANA system user 

HANA administrator 

name 

hdbadm / 

<Master Password> 

Additional user for HANA lifecycle management – start/stop, 

administration functions, recovery. 

Generic HANA DB user BPINST / Welcome1 Generic user that can be used to access HANA DB  

2.4.3 SAP NetWeaver JAVA application server 

Name Value Description 

SID J2E System ID of the SAP JAVA system 

Instance Number 01 The instance number of the central instance (CI) 

ASE administrator name sybadm /  

<Master Password> 

Additional user for Sybase ASE lifecycle management – start/stop, 

administration. 

JAVA administrator name Administrator / <Master 

Password> 

Additional user for JAVA lifecycle management – start/stop, 

administration, functions, recovery. 

Access to SAP NetWeaver Administrator: 
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Name Value Description 

https://vhcalj2eci.dummy.nodomain:50001/nwa 

Additional JAVA user BPINST / Welcome1 Generic user in case other users are locked 

2.4.4 SAP BusinessObjects BI platform 

Parameter ID Parameter Value Note 

Administrator name Administrator / <Master 

Password> 

Use for all administrative functions of the BI 

platform e.g., in CMC 

BI Power User BPINST / Welcome1 Use for BI Launchpad 

SQL Anywhere DB user dba / Appl1ances Use to log on to the DB of the BI platform on 

Linux backend stored under 

/data/bobj/sqlanywhere/database 

BI Platform Linux backend user bipadm / Welcome1  

 

In the logon screen (http://bihost:8443/BOE/BI), use bihost:6400 as system and Enterprise authentication. Usage of the bihost 

alias requires local host file mapping when using local PC access (see section 2.3). The Windows remote desktop has the 

mapping pre-configured. 

2.4.5  Windows Frontend Server Details  

Connect to the Frontend server using the information in the table below.  

SAP does not provide a separate MS Windows Terminal Server license as part of the appliance; hence, you can connect with a 

maximum of two concurrent users (with different user IDs) at the same time. The Administrator account is pre-configured, and 

you may create additional user IDs in the local user administration of the remote desktop if needed.  

If you want to use the remote desktop with higher user numbers, please apply your own MS Terminal Server license to the 

remote desktop and potentially choose a larger sizing for the RDP in the Cloud Appliance Library console. But for these high 

user numbers it’s typically better to enable access via local PCs to the appliance system.  

 

Name Value Description 

IP Address <IP Address> The IP address of your frontend server appliance you created in 

SAP Cloud Appliance Library (use the “external” IP address) 

User Administrator /  

<Master Password> 

User for the Windows frontend server. This is a local user on the 

remote desktop. Only one Administrator user can logon to the 

front-end server at the same point in time. 

 

A note on browsers on the RDP:  

https://vhcalj2eci.dummy.nodomain:50001/nwa
http://bihost:8443/BOE/B
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Google Chrome and Firefox are pre-installed on the Remote Desktop. In the Fiori launchpad, you might find slightly different 

rendering behaviors depending on the browser version. If you encounter rendering problems, please search for SAP Notes how 

to potentially fix them. 

If you want to access the Fiori Launchpad with a local browser, please be sure to map your local host file as described in section 

2.3 of this document or on https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html → Quick Start Guide since 

otherwise some Fiori applications (e.g. WebGUI or Web Dynpro) will not work correctly. 

 

A note on Eclipse and SAP plugins 

You can connect via SAP HANA Studio and the SAP Developer Tools for Eclipse (e.g. to examine the HANA DB structures or ABAP 

artifacts such as CDS views). 

For this you will need to install Eclipse and the respective SAP plug-ins for Eclipse on the remote desktop: 

• Double-click on the desktop icon "SAP Dev Tools for Eclipse" (this will start a PowerShell script to automatically install 
Eclipse and the respective SAP plug-ins) 

• Accept the Terms & Conditions 

• Wait until Eclipse and the SAP plug-ins have been installed (this will take ~ 10 minutes and Eclipse will be opened in 
the background during the installation, ignore any pop-ups that might show up) 

• Once the installation has successfully finished, click on the newly created Eclipse icon "SAP Dev Tools for Eclipse" on 
the remote desktop to launch Eclipse 

• The prompt to set a master password is optional and pops out when opening certain perspectives 

• In Eclipse, open the desired perspective (HANA Administrator / Modeler, ABAP, ...). The most important system 
entries have been automatically set up in Eclipse, only the passwords need to be provided 

• If there are problems with the automated PowerShell script, you can re-run it, or download and install Eclipse and the 
SAP plug-ins manually via SAP Development Tools  (choose a release that has the ABAP and HANA Tools available as 
add-ons) 

2.4.6 Accessing Your Appliance on Linux Level 

You can access the Linux backend system of your appliance (ABAP / JAVA / BI) as root using secure SSH tools, e.g., PuTTY 

For information how to access an appliance on OS level, go to https://cal.sap.com/catalog#/support → General Technical 

Questions → How to connect to a running appliance via the secure shell protocol (SSH)? 

 

Parameter ID Parameter Value Note 

OS User Name root The default Linux administrator user 

OS Password <none> Use the generated private key with SSH tools 

 

Note:  

You must use the private key (file format .pem) that was generated in the last step of the Create Appliance wizard from SAP 

Cloud Appliance Library. During the creation, you were asked to either store the key file attached to your appliance within SAP 

CAL or download it to a local secure file share on your computer. 

https://www.sap.com/cmp/oth/crm-s4hana/s4hana-on-premise.html
https://tools.eu1.hana.ondemand.com/
https://cal.sap.com/catalog#/support
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2.4.6.1 Starting/stopping your system 

The easiest way for a restart is the Reboot button in the SAP CAL console, however, this will typically need 10-15 minutes in 

total. 

As a faster alternative you can also use the SAP Management Console on the remote desktop. User credentials are <sidadm> 

/ <master password>  (with sidadm being one of s4hadm / hdbadm / j2eadm depending on the component). 

And lastly, you can also do it on Linux shell level with the usual sapcontrol commands, eg. sapcontrol -nr 00 -

function StartSystem - entered on the virtual machine for S/4 & HANA DB - starts the S/4 system (see the generic 

documentation of sapcontrol for details).  

The instance number for the -nr parameter can be found earlier in this guide. 

 

 

 

https://help.sap.com/docs/SAP_S4HANA_ON-PREMISE/b1c78119f8634ae1b933b60f02975a05/471d6feeff6e0d46e10000000a155369.html?locale=en-US
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3 Licenses & fees 

SAP Cloud Appliance Library is a delivery channel for quickly using SAP on-premise software products in a hyperscaler 

environment. 

Therefore, three separate license / cost factors need to be considered, each depending on the duration that your system should 

be used:  

a) the SAP on-premise product (e.g., SAP S/4HANA) 

b) SAP Cloud Appliance Library 

c) the chosen hyperscaler 

 

This table gives an overview about the different aspects. Details are mentioned in the paragraphs afterwards. 

The third column in the table below (on-premise installation) is an alternative to SAP Cloud Appliance Library and not covered 

in detail in this document (please see SAP Note 2041140 for details). 

 

 

 

 

 

https://launchpad.support.sap.com/#/notes/2041140
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 First 30 days: Running your appliance as trial 

In the first 30 days, the SAP license fees (Cloud Appliance Library & S/4HANA) are waived. During this period, you only need to 

bear the hosting fees of your cloud provider.  

The 30-day period starts when you accept the form for the trial agreement in the Cloud Appliance Library console (after clicking 

on “Create Appliance”).   

During the instantiation, the S/4HANA system will generate a temporary license key that is enough for exploration purposes.  

 Beyond 30 days: Running your appliance with SAP licenses  

If you want to use an appliance beyond the 30-day trial period (i.e. unlock the appliance template in SAP CAL), you need to 

obtain two SAP licenses: 

1. The SAP Cloud Appliance Library (SAP CAL) subscription 

2. The SAP product licenses for the product(s) that are bundled within your appliance (i.e. SAP S/4HANA and HANA DB 

licenses in the case of the SAP S/4HANA Fully-Activated Appliance) 

 

The validity of these licenses will be automatically checked after the first 30 days. In case of a missing license component an 

error message will be displayed in the SAP Cloud Appliance Library console and the respective appliance will stay in status 

“Suspended”. 

The cloud provider fees will stay the same as during the first 30 days. 

You can continue to use a trial appliance from the first 30 days under these conditions, all your changes in that appliance will be 

preserved once you unlock the appliance template.  

 

Note for SAP Partners: 

For SAP partners, application TD_... or DEV_... licenses will be sufficient as well (in combination with an SAP CAL subscription). 

Please see SAP PartnerEdge for details. 

3.2.1   SAP Cloud Appliance Library subscription 

You can purchase the subscription package via the SAP Store on 

https://store.sap.com/dcp/en/product/000000000008900303/sap-cloud-appliance-library . 

The minimum subscription is 3 months for one appliance (i.e., you can have exactly one appliance active at a time during these 

3 months). You can also choose longer subscription periods and higher appliance numbers (i.e., you can activate multiple 

appliance templates in parallel).  

In the SAP Store, you will need an S-user that is allowed to purchase in SAP Store.  

Please make sure that the SAP Store user and the SAP CAL user belong to the same organization, otherwise the mapping 

between the license and the to-be-unlocked appliance is not possible. In case these two users do now belong to the same 

organization, please see this blog how to resolve this.  

https://calstatic.hana.ondemand.com/res/docEN/96d12c4fb8ff4fd4a61e5dcc55cd16c4.html
https://partneredge.sap.com/en/partnership/licenses/tdd/other_services.html
https://store.sap.com/dcp/en/product/000000000008900303/sap-cloud-appliance-library
https://community.sap.com/t5/technology-blogs-by-sap/how-to-keep-an-expiring-trial-appliance-in-sap-cloud-appliance-library/ba-p/13327115
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3.2.2 SAP product licenses 

3.2.2.1 SAP S/4HANA Enterprise Mgmt. & SAP HANA DB 

To use the SAP S/4HANA Fully-Activated Appliance under your own SAP Product License Agreements, you need to possess at 

least a license for the SAP HANA DB (application runtime) and for SAP S/4HANA Enterprise Management professional use.  

If you don’t possess these (trial) licenses already, please obtain them via your SAP account executive.  

The Cloud Appliance Library infrastructure checks whether the customer/partner organization of the S-user who created the 

appliance in SAP Cloud Appliance Library possesses these licenses. Only if this check is passed, the appliance can be activated in 

SAP Cloud Appliance Library beyond 30 days. 

The licenses entitle your organization to use the virtual appliance, however, since technically you will still be running under the 

90-day temporary license key, we recommend generating your own license key and apply it to your system as soon as possible. 

90 days after the initial appliance creation, the appliance will stop working without these technical license keys (see the next 

chapter for details). 

 

Note:  

At least the following separately licensed SAP S/4HANA capabilities are also configured and described in the pre-configured 

demo scenarios of the virtual appliance. These capabilities will technically work in your appliance without entering dedicated 

license keys for them, however, they might not be part of your customer-specific license agreement for implementation / 

production systems. 

 

• SAP S/4HANA Finance for cash mgmt. 

• SAP S/4HANA Finance for receivables mgmt. 

• SAP S/4HANA for advanced compliance reporting 

• SAP Business Planning and Consolidation, add-on for S/4HANA 

• SAP S/4HANA for extended planning 

• SAP S/4HANA Advanced Available-to-Promise 

• SAP S/4HANA for Advanced Variant Configuration, standard 

• SAP Portfolio and Project Management for SAP S/4HANA professional 

• SAP Enterprise Master Data Governance for SAP S/4HANA 

• SAP S/4HANA Advanced Available-to-Promise 

3.2.2.2 Optional: SAP BusinessObjects BI Platform licenses 

If you chose to use the optional SAP BusinessObjects Platform in your appliance the temporary license key for BI will be valid for 
30 days.  It needs to be replaced by your own permanent key for the BI platform after that time if you want the BI platform to 
work. 
 
If you don’t apply a permanent license key, the BI platform cannot be used anymore.  
The other appliance components (S/4HANA etc.) will not be affected and can be used even without the BI platform.  
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 Beyond 90 days: License key installation required 

Latest 90 days after appliance creation (but better directly after unlocking the appliance template in Cloud Appliance Library 

after 30 days), you need to apply a valid license key to the system components.  

• SAP S/4HANA 

• SAP HANA database 

• SAP NetWeaver J2EE platform 

• Optional: SAP BusinessObjects BI platform (temporary license key will expire after 30 days !) 

The first three are part of the SAP S/4HANA license; the BI platform needs to be licensed separately.  

 

To get license keys for your system components, you first need to register them as a customer installation (see 

https://support.sap.com/en/my-support/systems-installations.html).  

Afterwards you can request license keys via the SAP license key application (https://support.sap.com/licensekey).  

During the license key generation, you will be asked for certain parameters (hardware keys and other system properties). The 

table below has the details. 

For S/4HANA and JAVA, you can also choose to generate a “Maintenance Certificate” together with the license key. The 

Maintenance Certificate is valid for 3 months and only needed for advanced system operations e.g., the installation of add-ons 

or support packages. It doesn’t affect the system in general so you can decide whether to take it or not. More details are here.  

 

For more information about how to generate and install product license keys, please see this step-by-step video (using an SAP-

internal license key but the principle is the same for customers & partners once you have registered a technical installation for 

SAP S/4HANA under your customer number – please check with your inhouse SAP team or your responsible partner in case of 

questions).  

 

SID Product Version DB OS Comment Where to get the hardware key and apply the 

license key  

HDB SAP HANA, platform 

edition 

SAP HANA 2.0, 

platform 

edition 

- Linux License type: SAP In-

memory Appliance platform 

Quantity: 256 GB Memory 

Volume  

HANA Studio: log on to system DB with SYSTEM 

user; right-click on system → Properties → 

Licenses. 

HANA Studio on remote desktop has pre-

configured entry for system DB. 

In a local HANA Studio use host name 

vhcalhdbdb or IP address of ABAP/JAVA VM; 

instance number 02; multiple containers > 

system database. 

S4H SAP S/4HANA SAP S/4HANA 

2023 

SAP HANA 

database 

Linux N/A Log on to S/4HANA with SAP GUI and use tCode 

/nSLICENSE 

J2E SAP NetWeaver SAP NetWeaver 

7.5 

Sybase 

ASE 

Linux As license type, select 'J2EE 

- Web AS JAVA' 

 

 

https://vhcalj2eci.dummy.nodomain:50001/nw

a with Administrator user → Configuration → 

Infrastructure → Licenses. 

BIP Optional:  SAP 

BusinessObject

s Business 

- Linux Material:  

Choose SAP BO BI Platform 

(with fitting license KPI e.g., 

BOE CMC with user Administrator / <Master 

Password> 

(https://bihost:8443/BOE/CMC) → Licenses 

https://support.sap.com/en/my-support/systems-installations.html
https://support.sap.com/licensekey
https://support.sap.com/en/release-upgrade-maintenance/maintenance-information/maintenance-certificate.html
https://www.youtube.com/watch?v=4BZ2T42yhMY&list=PLWV533hWWvDmww3OX9YPhjjS1l1n6o-H2&index=20
https://vhcalj2eci.dummy.nodomain:50001/nwa
https://vhcalj2eci.dummy.nodomain:50001/nwa
https://bihost:8443/BOE/CMC
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SID Product Version DB OS Comment Where to get the hardware key and apply the 

license key  

SAP BusinessObjects 

Business Intelligence 

platform 

Intelligence 

platform 4.3 

concurrent sessions CS,…) 

and version XI 4.3 

 

 

Note to SAP employees:  

You can generate SAP-internal license keys (18 months validity) directly in the license key application without having to register 

your system (just enter the needed parameters and the hardware key). 

 

3.3.1  What to do if your temporary license key has expired 

If you missed to install your own permanent license key before the temporary 90-day key has expired, your system will stop 

working, hence, if you experience connectivity errors roughly three months after the appliance creation think of an expired 

license key in the first place.  

The procedure is now a bit more difficult since you need to get to a fully-licensed HANA DB first before you can install the S/4 

license key, therefore follow these steps:  

1. Apply the HANA DB license key as described above. When you log on to the HANA system DB with the SYSTEM user, 

you will only have limited options (incl. some warning messages), but the license key installation works as usual. 

2. Restart the S/4HANA ABAP system. The easiest way is to use the Reboot button in the CAL console, but you can also 

do it on Linux OS level with the sapcontrol command. 

3. When the S/4 appliance is active again, apply the license key to S/4HANA as described above. You need to do this in 

client 000 with the user SAP* / <Master_Password>. Afterwards, HANA and S/4HANA should run as before. 

4. Apply the JAVA server license key as described above within 30 minutes after a re-boot or activation of the 

appliance. After this period, the JAVA server will go down until the next reboot / re-activation. 

5. For SAP BusinessObjects (temporary license key expires after 30 days), apply the license key as described above (no 

special considerations).  

3.3.2 Product license checks in the CAL console 

The CAL console provides an online license check under Appliances → License Status, see screenshot below.  

This comprises SAP S/4HANA, SAP HANA DB, SAP NetWeaver (JAVA), and the SAP BI platform. 

Some hints:  

- The license status is polled automatically every 5-10 minutes by the CAL console, please allow for some time to 

refresh after you have changed anything in the license keys 

- If you have two license keys in parallel in the system (eg. one temporary and one permanent in the JAVA 

platform), the check might show false negative results 

- The HANA DB keys will only be recognized when applied to the system DB 

 

https://support.sap.com/licensekey
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4 Security Aspects in SAP Cloud Appliance Library 

 Internet ports for accessing your system 

By default, the below ports are opened for your appliance (i.e., this is the inbound firewall of your cloud provider). The access 

from your local computer to your appliance happens via those ports.  

You can edit/add/remove ports manually in the appliance details (click on the appliance link in the Cloud Appliance Library 

console → Edit → Virtual Machine → Access Points). 

If you want to tighten the security, open as few ports as really needed for your scenario.  

Especially the port 3389 of the remote desktop could be exposed to brute-force hacking attacks from the Internet.  

 

Virtual 

Machine* 

Protocol Port (open by 

default) 

Description 

ABAP SSH 22 Used for secure connection to Linux-based server operating system 

ABAP HTTPS 44301,  44300  Used for access of a local web browser to appliance (Fiori etc.).  

44301 via Web Dispatcher, 44300 via ABAP ICM directly 

ABAP HTTP 50000 Standard HTTP port for ABAP 

ABAP HTTPS 8443 Access to integrated Cloud Connector 

ABAP SAP GUI 3200 Used for access of local SAP GUI to appliance 

ABAP TCP 3300 Used for connection of ABAP Development Tools (Eclipse-based) to SAP S/4HANA ABAP 

repository & RFC calls to other systems if intended 

ABAP TCP 30213 / 30215 Used for connection of SAP HANA Studio to HANA DB 

JAVA SSH 22 SSH connection to Linux operating system (e.g., for PuTTY) 

JAVA HTTPS 50001 Used for access to SAP NetWeaver Administrator and other web-based J2EE applications 

BIP SSH 22 Used for secure connection to Linux-based server operating system 

BIP HTTP 8443, 6400 Used for HTTP connection to BI platform 

WIN RDP 3389 Used for access from MS Windows remote desktop connection 

* ABAP = SAP S/4HANA  & SAP HANA DB; JAVA = SAP NetWeaver 7.50 AS JAVA incl. ADS (Adobe Document Service) ; BIP = SAP BusinessObjects BI Platform 

4.2 ; WIN = MS Windows Remote Desktop 

 

Please also make sure that any outbound firewall (e.g., if you are behind a corporate firewall) allows access through the needed 

ports. If you encounter problems behind a firewall, a good test is to use a public network (e.g., from home) or test access via 

the delivered remote desktop.  
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 Further network security considerations 

Be aware that creating your appliances in the public zone of your cloud provider (i.e., the “open Internet”) is convenient but 

less secure than providing it within your corporate network.  

In addition, we also recommend that you limit the access to your appliances by defining a whitelisted IP range of IP addresses 

that may access your appliance (e.g., the subnet of your company). With this, only computers within the white-listed IP range 

can access your system via the specific port. You can maintain the IP Range settings in the Cloud Appliance Library console → 

Edit → Virtual Machine → Access Points., using CIDR notation.  

The more complex but also more secure alternative to public Internet is to set up a virtual private cloud (VPC) or other 

dedicated access channels from your corporate network, please see the documentation of your hyperscaler how to do this.  

Note that when using HANA based appliances, HANA systems are not installed individually but cloned from a template system. 

Because of this cloning process, the existing root keys are cloned. For more information, see this SAP Note 2134846 - HANA 

encryption key handling during system cloning. 

 ABAP user roles and profiles  

The ABAP business users listed in chapter 2 have a large set of roles and typically a default password Welcome1. 

If you plan to release the appliance to a larger set of users (especially in the Internet scenario), it is advised to restrict/lock the 

access with these users (or change the initial passwords) and create your own users with fitting roles and authorizations (see 

also the section “Recommended post-installation steps” earlier in this document). 

This can be done with the standard user management capabilities (e.g., tCode SU01, etc.). 

 SSL/TLS Certificates 

The appliance comes with a certificate that was self-signed by SAP. Most local browsers will issue a warning message that such 

a certificate is untrusted, and you will need to add the affected URLs (Fiori launchpad and others) to the list of trusted sites 

once.  

Hence, if you see messages about unsafe connections, untrusted certificates, etc., please click on “Proceed” or “I know the 

risk”, etc. (the screens and needed clicks will vary depending on the browser). 

As an alternative, you can also apply your own trusted certificate to the system if you have assigned your own host name as 

described in chapter 2.3.2 of this guide. 

On the demo walkthrough page a technical demo guide (in section (A) Demo Guides → Technical) explains how to install a free 

90-day Let’s Encrypt SSL certificate. 

Please be aware that the mentioned guide is meant to provide a quick workaround and might not comply with the security 

recommendations that are issued by your company or by SAP in general. 

 

On the delivered remote desktop, the self-signed certificate has already been imported into the store with trusted certificates, 

and you will not see a warning if you access the Fiori launchpad. The web sites of the J2EE server or the SAP Cloud Connector 

will still display warnings, please acknowledge the risk and continue as outlined above. 

http://en.wikipedia.org/wiki/Classless_Inter-Domain_Routing
https://launchpad.support.sap.com/#/notes/2134846
https://launchpad.support.sap.com/#/notes/2134846
https://blogs.sap.com/2019/04/23/sap-s4hana-fully-activated-appliance-demo-guides/
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5 Appliance Template Provisioning in SAP Cloud 
Appliance Library  

If you have a user in SAP Cloud Appliance Library, you need to meet the following prerequisites before starting to use the SAP 

Cloud Appliance library: 

 

Cloud Provider Configurations 

You have a valid account in one of the cloud providers supported by SAP Cloud Appliance Library. If you already have an active 

cloud provider account, you can proceed directly with the next section. Otherwise, navigate to the cloud provider home page 

and sign up. 

For more information about the supported cloud providers, see the FAQ page. 

 

Navigate to SAP Cloud Appliance Library 

Open the SAP Cloud Appliance Library in your Web browser using the following link: https://cal.sap.com  

For more information about how to use appliance templates in SAP Cloud Appliance Library, see the official documentation of 

SAP Cloud Appliance Library (choose Support → Documentation link and choose   (expand all) button to see all documents 

in the structure). You can also use the context help in SAP Cloud Appliance Library by choosing the Help panel from the right 

side. 

 

https://caldocs.hana.ondemand.com/caldocs/help/General_FAQs.pdf
https://cal.sap.com/
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6 Appendix 

 Installed Technical Component Details 

6.1.1 SAP S/4HANA 2023 (FPS02) on SAP ABAP application server 7.58 & SAP 
HANA DB 2.00.079 

The SAP Kernel release is 793 PL 101 

 

Software Component Name Software 
Component 
Release 

Support 
Package 
Level 

Highest Imported 
Support Package 

Short Description of Software 
Component 

SAP_BASIS 758 2 

SAPK-
75802INSAPBASIS SAP Basis Component 

SAP_ABA 75I 2 

SAPK-
75I02INSAPABA 

Cross-Application 
Component 

SAP_GWFND 758 2 

SAPK-
75802INSAPGWFND SAP Gateway Foundation 

SAP_UI 758 2 SAPK-75802INSAPUI User Interface Technology 

ST-PI 740 28 SAPK-74028INSTPI SAP Solution Tools Plug-In 

SAP_BW 758 2 

SAPK-
75802INSAPBW SAP Business Warehouse 

UIBAS001 758 2 

SAPK-
75802INUIBAS001 UI for Basis Applications 

MDG_FND 808 2 

SAPK-
80802INMDGFND S/4HANA MDG Foundation 

S4FND 108 2 

SAPK-
10802INS4FND S/4HANA Foundation 

MDG_APPL 808 2 

SAPK-
80802INMDGAPPL S/4HANA MDG Applications 

S4CEXT 108 2 

SAPK-
10802INS4CEXT S/4HANA Applications EXT 

S4CORE 108 2 

SAPK-
10802INS4CORE S/4HANA Core Applications 1 

S4HCM 101 11 

SAPK-
10111INS4HCM Human Resources 

S4HCMCAE 101 11 

SAPK-
10111INS4HCMCAE 

Subcomponent S4HCMCAE 
of S4HCM 

S4HCMCAR 101 11 

SAPK-
10111INS4HCMCAR 

Subcomponent S4HCMCAR 
of S4HCM 
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Software Component Name Software 
Component 
Release 

Support 
Package 
Level 

Highest Imported 
Support Package 

Short Description of Software 
Component 

S4HCMCAT 101 11 

SAPK-
10111INS4HCMCAT 

Subcomponent S4HCMCAT 
of S4HCM 

S4HCMCAU 101 11 

SAPK-
10111INS4HCMCAU 

Subcomponent S4HCMCAU 
of S4HCM 

S4HCMCBE 101 11 

SAPK-
10111INS4HCMCBE 

Subcomponent S4HCMCBE 
of S4HCM 

S4HCMCBG 101 11 

SAPK-
10111INS4HCMCBG 

Subcomponent S4HCMCBG 
of S4HCM 

S4HCMCBR 101 11 

SAPK-
10111INS4HCMCBR 

Subcomponent S4HCMCBR 
of S4HCM 

S4HCMCCA 101 11 

SAPK-
10111INS4HCMCCA 

Subcomponent S4HCMCCA 
of S4HCM 

S4HCMCCH 101 11 

SAPK-
10111INS4HCMCCH 

Subcomponent S4HCMCCH 
of S4HCM 

S4HCMCCL 101 11 

SAPK-
10111INS4HCMCCL 

Subcomponent S4HCMCCL 
of S4HCM 

S4HCMCCN 101 11 

SAPK-
10111INS4HCMCCN 

Subcomponent S4HCMCCN 
of S4HCM 

S4HCMCCO 101 11 

SAPK-
10111INS4HCMCCO 

Subcomponent S4HCMCCO 
of S4HCM 

S4HCMCCZ 101 11 

SAPK-
10111INS4HCMCCZ 

Subcomponent S4HCMCCZ 
of S4HCM 

S4HCMCDE 101 11 

SAPK-
10111INS4HCMCDE 

Subcomponent S4HCMCDE 
of S4HCM 

S4HCMCDK 101 11 

SAPK-
10111INS4HCMCDK 

Subcomponent S4HCMCDK 
of S4HCM 

S4HCMCEG 101 11 

SAPK-
10111INS4HCMCEG 

Subcomponent S4HCMCEG 
of S4HCM 

S4HCMCES 101 11 

SAPK-
10111INS4HCMCES 

Subcomponent S4HCMCES 
of S4HCM 

S4HCMCFI 101 11 

SAPK-
10111INS4HCMCFI 

Subcomponent S4HCMCFI of 
S4HCM 

S4HCMCFR 101 11 

SAPK-
10111INS4HCMCFR 

Subcomponent S4HCMCFR 
of S4HCM 

S4HCMCGB 101 11 

SAPK-
10111INS4HCMCGB 

Subcomponent S4HCMCGB 
of S4HCM 

S4HCMCGR 101 11 

SAPK-
10111INS4HCMCGR 

Subcomponent S4HCMCGR 
of S4HCM 

S4HCMCHK 101 11 

SAPK-
10111INS4HCMCHK 

Subcomponent S4HCMCHK 
of S4HCM 

S4HCMCHR 101 11 

SAPK-
10111INS4HCMCHR 

Subcomponent S4HCMCHR 
of S4HCM 

S4HCMCHU 101 11 

SAPK-
10111INS4HCMCHU 

Subcomponent S4HCMCHU 
of S4HCM 
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Software Component Name Software 
Component 
Release 

Support 
Package 
Level 

Highest Imported 
Support Package 

Short Description of Software 
Component 

S4HCMCID 101 11 

SAPK-
10111INS4HCMCID 

Subcomponent S4HCMCID of 
S4HCM 

S4HCMCIE 101 11 

SAPK-
10111INS4HCMCIE 

Subcomponent S4HCMCIE of 
S4HCM 

S4HCMCIN 101 11 

SAPK-
10111INS4HCMCIN 

Subcomponent S4HCMCIN of 
S4HCM 

S4HCMCIT 101 11 

SAPK-
10111INS4HCMCIT 

Subcomponent S4HCMCIT of 
S4HCM 

S4HCMCJP 101 11 

SAPK-
10111INS4HCMCJP 

Subcomponent S4HCMCJP of 
S4HCM 

S4HCMCKR 101 11 

SAPK-
10111INS4HCMCKR 

Subcomponent S4HCMCKR 
of S4HCM 

S4HCMCKW 101 11 

SAPK-
10111INS4HCMCKW 

Subcomponent S4HCMCKW 
of S4HCM 

S4HCMCKZ 101 11 

SAPK-
10111INS4HCMCKZ 

Subcomponent S4HCMCKZ 
of S4HCM 

S4HCMCMX 101 11 

SAPK-
10111INS4HCMCMX 

Subcomponent S4HCMCMX 
of S4HCM 

S4HCMCMY 101 11 

SAPK-
10111INS4HCMCMY 

Subcomponent S4HCMCMY 
of S4HCM 

S4HCMCNL 101 11 

SAPK-
10111INS4HCMCNL 

Subcomponent S4HCMCNL 
of S4HCM 

S4HCMCNO 101 11 

SAPK-
10111INS4HCMCNO 

Subcomponent S4HCMCNO 
of S4HCM 

S4HCMCNZ 101 11 

SAPK-
10111INS4HCMCNZ 

Subcomponent S4HCMCNZ 
of S4HCM 

S4HCMCOM 101 11 

SAPK-
10111INS4HCMCOM 

Subcomponent S4HCMCOM 
of S4HCM 

S4HCMCPH 101 11 

SAPK-
10111INS4HCMCPH 

Subcomponent S4HCMCPH 
of S4HCM 

S4HCMCPL 101 11 

SAPK-
10111INS4HCMCPL 

Subcomponent S4HCMCPL 
of S4HCM 

S4HCMCPT 101 11 

SAPK-
10111INS4HCMCPT 

Subcomponent S4HCMCPT 
of S4HCM 

S4HCMCQA 101 11 

SAPK-
10111INS4HCMCQA 

Subcomponent S4HCMCQA 
of S4HCM 

S4HCMCRO 101 11 

SAPK-
10111INS4HCMCRO 

Subcomponent S4HCMCRO 
of S4HCM 

S4HCMCRU 101 11 

SAPK-
10111INS4HCMCRU 

Subcomponent S4HCMCRU 
of S4HCM 

S4HCMCSA 101 11 

SAPK-
10111INS4HCMCSA 

Subcomponent S4HCMCSA 
of S4HCM 

S4HCMCSE 101 11 

SAPK-
10111INS4HCMCSE 

Subcomponent S4HCMCSE 
of S4HCM 



 

37 
 

Software Component Name Software 
Component 
Release 

Support 
Package 
Level 

Highest Imported 
Support Package 

Short Description of Software 
Component 

S4HCMCSG 101 11 

SAPK-
10111INS4HCMCSG 

Subcomponent S4HCMCSG 
of S4HCM 

S4HCMCSI 101 11 

SAPK-
10111INS4HCMCSI 

Subcomponent S4HCMCSI of 
S4HCM 

S4HCMCSK 101 11 

SAPK-
10111INS4HCMCSK 

Subcomponent S4HCMCSK 
of S4HCM 

S4HCMCTH 101 11 

SAPK-
10111INS4HCMCTH 

Subcomponent S4HCMCTH 
of S4HCM 

S4HCMCTR 101 11 

SAPK-
10111INS4HCMCTR 

Subcomponent S4HCMCTR 
of S4HCM 

S4HCMCTW 101 11 

SAPK-
10111INS4HCMCTW 

Subcomponent S4HCMCTW 
of S4HCM 

S4HCMCUA 101 11 

SAPK-
10111INS4HCMCUA 

Subcomponent S4HCMCUA 
of S4HCM 

S4HCMCUN 101 11 

SAPK-
10111INS4HCMCUN 

Subcomponent S4HCMCUN 
of S4HCM 

S4HCMCUS 101 11 

SAPK-
10111INS4HCMCUS 

Subcomponent S4HCMCUS 
of S4HCM 

S4HCMCVE 101 11 

SAPK-
10111INS4HCMCVE 

Subcomponent S4HCMCVE 
of S4HCM 

S4HCMCZA 101 11 

SAPK-
10111INS4HCMCZA 

Subcomponent S4HCMCZA 
of S4HCM 

S4HCMGXX 101 11 

SAPK-
10111INS4HCMGXX 

Subcomponent S4HCMGXX 
of S4HCM 

S4HCMRXX 101 11 

SAPK-
10111INS4HCMRXX 

Subcomponent S4HCMRXX 
of S4HCM 

EA-DFPS 808 2 

SAPK-
80802INEADFPS S/4HANA DFPS 

EA-PS 808 2 SAPK-80802INEAPS S/4HANA PS 

FI-CAX 808 2 SAPK-80802INFICAX S/4HANA FI-CA Extended 

IS-OIL 808 2 SAPK-80802INISOIL S/4HANA IS-OIL 

IS-PRA 808 2 SAPK-80802INISPRA S/4HANA IS-PRA 

IS-PS-CA 808 2 

SAPK-
80802INISPSCA S/4HANA IS-PS-CA 

IS-UT 808 2 SAPK-80802INISUT S/4HANA IS-UT 

S4COREOP 108 2 

SAPK-
10802INS4COREOP S/4HANA Core Applications 2 

S4DEPREC 108 2 

SAPK-
10802INS4DEPREC S/4HANA Core Applications 3 

GBX01HR5 605 30 

SAPK-
60530INGBX01HR5 GBX01HR5 605 

UIAPFI70 902 2 

SAPK-
90202INUIAPFI70 UI SFIN 
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Software Component Name Software 
Component 
Release 

Support 
Package 
Level 

Highest Imported 
Support Package 

Short Description of Software 
Component 

UIHR002 100 26 

SAPK-
10026INUIHR002 

UI for ERP Human Capital 
Management 100 

UIS4HOP1 900 2 

SAPK-
90002INUIS4HOP1 UI for S/4HANA On Premise 

PERSONAS 300 18 

SAPK-
30018INPERSONAS 

PERSONAS - SAP GUI 
PERSONALISATION 

ST-A/PI 01V_731 3 SAPKITABC6 

Servicetools for SAP Basis 
731 and higher 

HOME DEV 0 - 

Customer Development 
(Standard) 

ZCUSTOM_DEVELOPMENT DEV 0 - 

Cloud-Ready Custom 
Development 

LOCAL DEV 0 - 

System Local Development 
(Standard) 

ZLOCAL DEV 0 - 
Cloud-Ready Local Custom 
Development 

6.1.2  SAP HANA Database & Plug-In Versions  

HANA Version: 2.00.076.00  

 

Plug-in Full Version 

AFL 2.00.079.0000 Build 1720768968-1530 

LCAPPS 2.00.079.0000 Build 1720768968-1530 

SAP_AFL_SDK_APL 4.203.2405.0 

VCH2023 2.00.079.00 Build 1720729199-1530 

6.1.3  SAP NetWeaver 7.50 application server JAVA with Adobe  Document 
Services installed  

ASE DB release is 16.0 PL 06. 

 

Product Name Name Version Vendor Description 

SAP NETWAVER 
J2EE 

7.50 30 sap.com SAP NETWEAVER 7.5: Adobe Document Services 

SAP NETWAVER 
J2EE 

7.50 30 sap.com SAP NETWEAVER 7.5: Application Server Java 
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6.1.4  Windows Remote Desktop Installed Components 

o SAP GUI & SAP Business Client (with Webview2 plugin for Edge) 

o MS PowerShell script for installing Eclipse and tools for HANA (Administration/Modeling) & ABAP Development 

(ADT) 

o SAP Microsoft Management Console for a convenient re-start of S/4HANA, HANA DB, and NW JAVA 

o Google Chrome / Mozilla Firefox 

6.1.5  SAP BusinessObjects BI Platform 4.3 

o SBOP BI PLATFORM 4.3 SP03 SERVER LINUX



 

 

 

www.sap.com/contactsap 

© SAP SE or an SAP affiliate company. All rights reserved.  See Legal Notice 

on www.sap.com/legal-notice for use terms, disclaimers, disclosures, or 

restrictions related to SAP Materials for general audiences. 

 

http://www.sap.com/legal-notice
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